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Chapter 1 - What is Macro Pro?

Introduction

Overview

Macro Pro is an enhanced Multiple Document Interface (MDI) text editor designed
specifically for creating CNC Custom Macro programs. Macro Pro v3.0 runs under
the 32 bit Microsoft© Windows operating systems 95/98 and NT.

The Macro Pro menu system has al of the Local, Common and System variables for
Custom Macro B predefined in easy to use list boxes. To insert a new variable, you
simply click on the Macro menu and choose the type of variable you want. A dialog
box will open with alist box that contains the predefined variables of this type.

The editor has all the standard features you expect in a Windows Text editor such as
Find/Replace, Copy, Paste, Open, Close and Print. Each of Macro Pro's menu items
will be explained in alater section.

What's New

Some of the features added to Version 3.0 include:

* True 32 bit program — There isn't any 16 bit code in Macro Pro 3.0
* File Extension Groups — Create up to 9 groups of file extensions

* Floating Dialog boxes — All of Macro Pro's dialog boxes now float on top alowing
you to keep them open while working in the editor.

* Office 97 style floating tool bars— Y ou can drag the menus anywhere you want
them. Right click over amenu and you can customize the menus.

* Fully Customizable Datafiles - All of Macro Pro's Macro Variables are now stored
as standard text files and can be modified by the user.

* Custom Entry Menu — Y ou can now include up to 25 of your own files as menu
itemsin Macro Pro.

* Optional Tools and Reference menus — CNCHelper's Tools and Reference menus
can be integrated into Macro Pro.

If you are new to Macro Pro, key features from Version 2.0 include:
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* Drag & Drop Editing - Just like Word for Windows©

* MDI - So you can open severd files at atime

* Code Library - A searchable library for code segments

» Comments — Add or remove parentheses from your program
* Recently Used Files- A list of the last 9 files opened

* Right Mouse Button Support for the Edit menu

* Unlimited File Size - File sizeis only limited by disk space

Installation

Macro Pro v3.0 is a 32 bit Windows application and requires Microsoft Windows
95/98 or NT 3.51 with SP5 or NT 4.0 with SP3. Thisis the only requirement for the
computer hardware. The faster the computer and the better the display, the better
Macro Pro will run. An 800 x 600 monitor resolution works much better than the
640 x 480 of VGA.

Running Setup

The Setup program is a Windows application. If Autorun is enabled on your
computer the setup program will start automatically. If not you can run the setup
program manually. To run the Setup program, click File, Run from the Windows
Start button. Type D:Setup (or E:Setup) and press ENTER where D or E isthe drive
letter of your CD-ROM drive.
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Chapter 2 - The Editor

The File Menu

Opening a File

Double click the Macro Pro Editor Icon in the Macro Pro group. The best way to get
to know Macro Proisto jump right in and use it. The setup program installed the
application programs from the manual in the data folder under the Macro Pro Editor
folder. We can use one of the application programs to illustrate the features of

Macro Pro.

Select File, Open and click on 10m_ind.pro in the file list. When you click on
10m_ind.pro in the List Box, the filename will be placed in the File Name text box.
See the next figure for an example.

open g

Look in:

I =3 zamples

e [ B

% 10m_are pro

10m_line pra
10m_ratvppra
10m_zlot.pro
10m_tool.pra

L]

10m_t=et pro
10marray.pro
10mblterpro
10mbtskp.pro
10mcircl pro
10rmecount pro

10metrbepro
10mramps pro
10mt=etlpro
fin_arc pro

Ai_array.pro
ém_blterpro

(2151 2] [0 2] [ ] [0

File name:

|1 Orn_ind.pro

Filez of tpe: IMacrn Files [*.proz* zub;® bat)

[ Open as read-only

|,

Open

Cancel

The Macro Pro Editor file open dialog

Command Line Arguments

Y ou can create a shortcut to Macro Pro and have it open afile automaticlly. All you
need to do is add the name of the file after the command to start Macro Pro. For
example, to start Macro Pro and open afile called 10m_ind.pro you would use this

Statement:
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D:\Program Files\Programming Unlimited\Macro Pro Editor\MACRO.exe

followed by
D:\Program Files\Programming Unlimited\Macro Pro Editor\SAMPLES\10m_line.pro

Y ou can have multiple files on the command line. 1f you add a second file saparate
it from the first with acomma. Do not use a space before or after the comma.

Saving Your Work

The current file name is displayed above the program on the document's window
pane. If you are creating afile from scratch UNTITLED:1 is displayed before you
save your work for the first time. Thisis areminder that you should save your work
in case of a power failure or other problem.

The first time you select Save from the File menu you will be presented with a
standard file save dialog box. Enter aname for the file in the box titled File Name.
See the next figure.

Save As
Save Ifﬂ Macra Pro Editor L! i f_ﬂfi b
[_Jdata Spellpro

2 Help

] Samples

% Achart txt

alarm sub
Readme txt

Flepame: | [ see |
Save az lype: IMacru:u Files [* prog* sub® bat) j Cancel |

[ Open as read-only

The File Save dialog

Using Save As

If you want to save your current work under a different file name, use the Save As
menu choice in the File menu. Y ou will be presented with the same Save As dialog
box that you saw in the above example. Enter a new file name and click OK.

Closing a File

To close thefile you are currently editing, select the Close item from the File menu.
If the file has changed since the last time you saved, a dialog box will appear. Y ou
have the choice of Saving the changes, losing the changes or canceling and returning
to the editor. See the next figure.
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Macro Pro Editor

!’@ The test in [Untitled: 1] haz changed.

['a you want ta zave the changes?

Mo i Cancel 1

The Save Changes dialog

The Code Library

The code library is a Microsoft Access 97 compatible database where you can store
often used code. We find that there are pieces of macro code that you use over and
over. Rather than trying to remember what program has the code you want, opening
it in the editor and then doing a cut and paste, you simply keep it in the code library.

Y ou can organize the code segments by category and then use Keywords to search
the category. Y ou can even include a searchable description of the segment.

Code Library
Setup

Cateqary [D: ; _:_I Insert

Cloge ' Help 1

Deseription:  |0kuma 05PS000/5020/7000 keyboard macra. Thiz macro checks the _f:j
keyboard and makes sure all switches are zet corectly. If Single Block or
M achine Lock iz selected, the macro ends.

K.ey wiords: ;.&Ialms uzer task Keyboard

Macro Code: |40 55E "
OALM

Paste fram | M1 IFIMDIN[128] AMD 2] EQ 2] NEND[MACHINE LOCK)

clipboard M2 IF[IDIM1T38] AMD 32] EQ 32] WALAT [LOAD AUTO SET]

MIIFIRYDIM[1T 28] AMD 1] EQ 1] HALAT [DRY RUN ON]

MAIF[WDIM[1128] AMD 128] EQ 128] NEND [SIMGLE BLOCK ON)
NS IF[YDIM[1132] AMND 2] MWE 2] NALAZ [FEED RATE OWER)
ME IF[YDIM[1132] AMD 8] WE 8] MALAZ [FEED RATE OWER)
N7 IFIWVDIM[132] AMD 1] EQ 1] MALASZ [FEED RATE OVER]
MNEIF[[WDIM[1132] AND 4] EQ 4] MALAZ [FEED RATE OVER])
M IF[YDIM[1132] AMD 16] ME 1E] MALAZ [SPINDLE OVER)
MT0IF[YDIM[1132] AWD 321 EQ) 32] NALAZ [SPIMDLE OYER) _‘_':j

-

4| 4 |Recod: 1 0f 3 pjnj Add | Delete | Refiesh | LUpdate

Search Criteria

Cat, ID: i E Search

Dezcription: ;
ey Wword: i Rezet

The Code Library

Organizing Code Segments

The code library uses three searchable fields to organize code segments - Category
ID, Keywords and Description. Y ou should give some thought to how you're going
to organize your code segments before using the library.
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The left arrow with the line in front
moves to thefirst record. Theright
arrow with the line in front moves to
the last record in the database.

The Category ID isatext field that can have up to 8 letters or numbers. For
example, you could use category 1 for probe related code, category 2 for pallets,
category 3 for alarms and so on. Y ou could also use the words probe, pallets and
alarms.

Then you would use the Keywords to narrow the search down. For example, 15M
for code specific to 15M controls, M32 for code specific to Mazak M32's or HAAS
for Haas code. Thisway you can narrow a search very quickly.

The sample database has an entry for a probe related segment for aMazak M32. To
find it you would enter Category ID PROBE, Keyword M32 and click Search.
Another sample segment is a keyboard alarm macro for an Okuma OSP control. To
find it enter Lathe for Category ID, Alarms for the Keyword and click search.

Adding an Entry to the Database

Thefirst step isto open afile that has the code you want to put into the database.
Highlight the code using the mouse or the keyboard. Right click the mouse and
select Copy to copy the text to the clipboard.

Click File, CodeLibrary... or CTRL+L to open the database. Click Add to create
anew record. Click Paste from Clipboard to paste the code into the database.
Now select a category from the category ID field, enter a description in the
description field and one or more keywords in the keyword field. Finally, click
Update to add the record. You could aso click the single right arrow on the Record
Selector to add the record.

The category field can have up to 8 characters, the description field can have 250
characters and the keyword field can have up to 400 characters. A practical limit for
Key words is probably closer to 50 characters or 5 words. The code segment can be
up to 32k.

Searching for an Entry

To search for an entry in the database, enter values for one or all of the following in
the Search Criteria frame:

* Cat. ID:
* Description:
» Key Word:

Click on Search. A dialog will appear to notify you that the search is complete.
Click OK to clear the dialog. To reset the database click Reset or do a search with
no entries in the Search Criteria text boxes.

Search Results

@ Search Complete

Inserting Code into Macro Pro

To insert the code segment into Macro Pro, click on Insert. The codeisinserted
where the cursor islocated and the library is closed.
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Deleting an Entry

To delete an entry, use search or the record selector to make the code segment the
current record. Then click Delete to delete the entry. Y ou will be prompted to
confirm the delete. If you have changed your mind click on No and the record wont
be deleted.

Confirm Delete

Are pau sure pau want to delete this recard?

1=
=]

Code Library Setup

The most important part of the code library is the category ID. The Category 1D
allows you to sort your datainto logical groups. For example if you have several
different types of controlsin your shop you might want to create categories based on
control type. The following figure shows the setup dialog:

Category Setup !
Current E ntries Mew Entry
Mame rm“_
b |haaz
b 32
O5FARO00 -
OSPR020 R emove |
QSF7000 -
Probe Cloze |
T3 =

4] 4 |Record: 1 0f 8 3 I Hl

Adding a new Category

To get started, click on Setup on the Code Library form. A new dialog will open
with the focus set to the New Entry text box. Type the new category into the text
box and click on Add. Y ou will then see the entry in the Current Entries list box.

Deleting a Category

To remove a category simply click onit in the Current Entrieslist box and then click
Remove. You will notice that Remove is grayed out unless you have an entry
selected.
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Setting the Default File Extension

When Macro Pro isinstalled, the Default file extension is.PRO. You can usethe
Preferences item in the Eile menu to change the default file extension. Changing
the default File extension alows you to create macros that can be easily used with
your CAM or DNC system.

To change the default file extension that is used when you save afile, click File,
Preferences. You will be presented with the following dialog box:

Macro Pro Editor Preferences !

Enter a File Extension to be
uzed with Macro Pro Programs

File Extenzion: |PRO

— File Types to Dizplay in the File Open Dialog———
File Tupesz [i.e. bk ini)

Insert

I‘. pro-=_sub;= txt

File Descrphor: [1.e Macra Files) Beplace

IHacm Files [*.pro;*.sub;* txt] Defaults

‘.src;".use;‘.tap;‘.lst Applicon Files Up
Batch Files [=.%]
Initiahzation Files [*.im]
All Files [=.7) Down
i
0Ok | Cancel
The Preferences dialog

Enter the new file extension in the box and click OK. Y ou must exit Macro Pro and
restart it before the change is effective. The file extension is saved in the Macro Pro
Editor.INI file in the Windows directory.

File Extension Groups

The Macro Pro Editor alows you to create up to nine groups of file extensions. For
example in the above figure Macro Filesis a group that includes the extensions
PRO, SUB and TXT. Thisgroup isthefirst onelisted in the list box. When the
Open File dialog is displayed this will be the default filter applied to files. That is,
any file that has afile extension of PRO, SUB or TXT will be displayed. Seethe
next figure:
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Open
Loak, jr: Ifﬂ M acro Pro Editor L! f;'ii b
|_Jidatal Spellpro

2| Achart.txt

alarm sub

""" Readme. t=t

Flepame: | [ Oeen |
Filez of tpe: IMacru:u Files [* prog* sub® bat) j Cancel |

[ Open as read-only

The File Open dialog with Macro Files displayed

Adding Groups

To add anew group click in the File Types text box and type an asterisk (*)
followed by a period (.) and the extension you want. 1f you want to enter more than
one file extension separate the extensions with a semi-colon (;). For example

* . pro;.sub;*.txt then click in the File Description text box and enter adescription. In
this example Macro Files (*.pro;*.sub;*.txt). Thisisjust adescription and isn't used
to open the files so the description can be anything you want. When you have
finished entering the extensions and description click Insert to add the entry to the
list. Remember, you can have up to nine groups of files.

Deleting an Entry

To delete afile extension group simply click on it in the list box and then click
Delete. The entry will be removed. If you change your mind and decide that you
didn't want to delete the group simply click Cancel and close the dialog.

Changing an Entry

If you decide to modify an entry simply click on it in the list box, make the changes
in the File Type and File Description text boxes and then click Replace. The entry
in the list box will be updated. If you change your mind and decide that you didn't
want to delete the group simply click Cancel and close the diaog.

Arranging Groups

You can click on an entry in the files list box and then use the Up/Down buttons to
changeits order in the list. Thefile groups are displayed in the File Open diadlog in
the same order that they appear in the list box.

Printing the Current File

To print the program you are working on, select thePrint option from the Eile menu.
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Exiting Macro Pro

To exit Macro Pro, select the Exit choice from the File menu. If the file has changed
since the last time you saved, adialog box will appear. You have the choice of
Saving the changes, losing the changes or canceling and returning to the editor. See
the above figure for an example of the dialog box.

The Edit menu

The Macro Pro editor is very easy to use. If you are familiar with Windows
programs, you will feel at homein Macro Pro. If thisis your first Windows program,
this section on editing will have you up to speed in no time.

To move through the file, press the Page Up or Page Down key on the keyboard.
You can a so use the mouse and click the Up or Down arrow on the scroll bar on the
right side of the screen.

Mouse click VS Keyboard

You can usethe ALT key with the underlined character on a menu or button instead
of using the mouse to select an action. For example, you can use ALT+E to select
the edit menu instead up clicking it with the mouse. Macro Prois very keyboard
friendly as most buttons and menus have this feature.

The Right Mouse button

Macro Pro supports the right mouse button when the pointer is over afile. When
you place the pointer over afile and click the right mouse button, the Edit menu will
appear on the screen. Y ou can then select the menu item you need and click the left
mouse button to choose the menu item. Thisis a great time saving feature once you
get used to it.

Undo Alt+Ekzp
Redo

Cut Chrl+
LCopy Chrl+C
Paste Chel+4

[ elets

Syntax Check...
Comments k
Change Upper Caze

Select All Text
Clear &ll Text
Inzert Time/D ate

The Edit Menu

Undo

The undo item does just what it says, It undoes the last edit you made. Undoin
Macro Pro has 255 levels. This means you can keep clicking Undo on the toolbar or
on the menu to undo changes made earlier.
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Redo

Redo isjust the opposite of Undo, it Redoes the Undo operation if you change your
mind.

Copy

The Windows environment makes copying text very easy. There are two ways to
copy text. Both methods require you to highlight the text before copying. The first
method has two steps.

1. Placethe caret, that's the blinking vertical bar, in front of the text and
press the SHIFT key. Press the ARROW key that pointsin the
direction of the text that you want to highlight. Y ou can also Click the
mouse before the text and drag it over the text you want to copy.

2. Pressthe CTRL key and the Insert key at the same time. This copiesthe
text to the Windows Clipboard. Y ou can paste the text back into the
Macro Pro file or into any other Windows program. Thisis one of the
advantages of the Windows environment. Y ou can easily share text
between two applications.

The second method uses a menu command to copy the text.
1. Highlight the text as in the above example.

2. Select Edit, Copy from the Menu Bar. This places the text on the
Windows Clipboard like the above method did.

Drag & Drop

Macro Pro also supports Drag & Drop editing. 1f you want to copy text from one
place to another simply highlight it, hold the left mouse button and the CTRL key
down then drag the text to a new location. When you press the left mouse button, the
cursor will change to show that drag & drop isenabled. This takes some getting

used to but it's very fast once you get used to it.

Paste

Inserting text is essentially the opposite of copying. Again there are two methods,
one from the keyboard and one from a menu. To use the keyboard to insert text
follow these two steps:

1. Placethe caret, that's the blinking vertical bar, where you want the text
inserted.

2. Press SHIFT and INSERT at the same time. The text will be inserted at
the caret and any text following the caret will be move out of the way.

To use the Menu method:

1. Placethe caret, that's the blinking vertical bar, where you want the text
inserted.

2. Sdlect EDIT, PASTE from the menu bar. The text will be inserted at
the caret and any text following the caret will be move out of the way.
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Cut

Cut deletes highlighted text from the file and copiesit to the Windows clipboard.
Y ou can then move the mouse to a new location and select Paste to paste the text
back into thefile.

Delete

This menu item deletes the highlighted text. Thetext isn't copied to the clipboard.
If you want to copy the highlighted text, use the Copy menu item followed by Paste.

Syntax Check

Macro Pro has a basic Syntax Checker built in. This new feature under the Edit
menu is used to check your macro for syntax errors. The checker reads each line of
the macro and verifies that there are an even number of parentheses and brackets on
theline. 1t will aso find misspelled words like WHILE, THEN, GOTO, Etc. It will
not find errors such as | F[#2G#4] GOTO because the G (which should be GE) is
followed by a non-alpha character.

If an error isfound in your macro, the checker will stop and highlight the error. You
make the correction in the Change To: box and click Change. The rest of the line
will be check for additional errors. The following figure shows the syntax checker in
action:

Macro Syntax Checking !
Mumber of nes Scanned:

Word Not Found

|531|Eu25F[u1 19- 6]

Change To:
|l331 FZH#26F[1#119=.6]

Start | Change | Skip Eloze

The Syntax Checker dialog

Comments

Thisisanew featurein version 3.0 that can save you alot of time. If you want to
add comments to your macro or comment out (skip) part of your macro without
deleting it, use this menu item. Simply type the comments you want and then
highlight them. Select Comment, Add Comments and parentheses are added to the
text. You can aso use CTRL + A to add Comments. Thisis much easier than
typing individual parentheses for each line.

Add Comments
Femove Comments

The Comments menu
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To remove parentheses, simply highlight the text and select Remove Comments or
press CTRL+B.

Change Uppercase

The most CNC controls will only except Uppercase letters. If you import text that is
not uppercase, don't worry. Macro Pro has a menu item to change the text to
uppercase. Select Edit, Change To Uppercase and al text is changed to uppercase.

Select All

This menu item simply highlights the whole file. Thisis useful if you want to copy
the file to another file.

Clear All

This menu item deletes all thetext in thefile. Thetext isn't copied to the clipboard.
If you want to copy a complete file use the Select All menu item followed by Copy.

Time/Date

This menu item inserts the current time and date enclosed in parentheses into file.
Thisisuseful if you want to track edits to the macro. An example of atime/date
entry is (1/11/99 10:06:11 PM).

The Search Menu

Eind

Macro Pro has atext search feature to help you locate a specific string of text in your
program. To use the text search feature, select Search, Find... from the menu bar. A
dialog box will open prompting you for the string to search for. The next Figure
shows the dialog box.

¢ i Find [_ (O]
_v_I Search

r Options —— — Cancel
| [ Match Case
I~ Whole Words Only

Find What: |WHILE

D[igin ........................................... =

i+ From Cursor

i,.. D ilBCtiDn .......................................
i T Up & Down

i~ Entire Scope

The Find dialog

Enter the text you want to locate and click OK. If the text islocated in the program,
it will be highlighted to make it more visible. By default, the file is searched from
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the cursor down. You can click Entire Scopein the Origin Frame to look in the
whole program. Y ou an also click the Find button on the tool Bar . To find

_— . &
the next occurrence you can click binoculars with the arrow under them.

Replace

Macro Pro has atext replace feature to help you replace a specific string of text in
your program. To use the text search feature, select Search, Replace... from the
menu bar. A dialog box will open prompting you for the string to search for and the
string to replace it with. The next Figure shows the dialog box.

i i Replace =] =
Find What: ;#551 _v_I Search
HNew Text: §u5521 j Cancel
— Optiong — —

[~ Match Case
I~ Whole Waords Only

Origin
' From cursor

" Entire Scope

.Directiun ........................................
 Up {* Down

The Replace dialog

Enter the text you want to replace in the Find What: text box and the replacement
text in the New Text: box and click OK. If the text islocated in the program, it will
be highlighted and a new dialog box will appear. Thisdialog givesyou the
following choices:

* Yes Replace this occurrence and continue searching

* No Skip this occurrence and find the next one.

* One Replace this occurrence and stop searching

* All Replace all occurrences without further prompting
* Cancel Stop the search and return to the editor

i i Replace Confirm =] =

Replace this occurrence?

One | All | LCancel |

The Replace Confirmation dialog

By default, thefile is searched from the cursor down. Y ou can click Entire Scopein
the Origin Frame to look in the whole program.
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Using Book Marks

Macro Pro alows you to add book marks to your code. Book marks allow you to
quickly jump to different parts of your program. Y ou can add as many book marks
asyou like. Thetext on the line with the book mark will be colored the same as the
Windows desktop. Book marks aren't saved with the program.

Adding a Book Mark

Y ou can use the Add Book Mark item of the Search menu or the Book Mark icon on
the tool bar to add abook mark. Thisiswhat the Add Book Mark icon looks like:

% The actual book mark will be placed where the caret isat ontheline. You can
use the "Column =" display on the status line to see what the current caret position is
if you want to place the book mark at an exact location.

Jumping to a Book Mark

Y ou can use the Goto Book Mark item of the Search menu or the Goto Book Mark
icon on the tool bar to jump to abook mark. Thisiswhat the Goto Book Mark icon
looks like:

b When you use Goto Book Mark it will place the caret on the line with the next
book mark and at the column where the mark was added. If you keep clicking Goto
Book mark you will be cycled through all of the existing book marks.

The Macro Menu

Thisisthe real purpose of Macro Pro. The variables are located in the M acro menu
on the menu bar.

Inserting Variables

To insert amacro variable, simply place the blinking caret where you want the
variable inserted, and click the M acr o menu.

The variables are arranged into logical groups. For example, the variables related to
tool length offset (Geometry & Wear) are grouped together under the menu choice
Mill Tool Length Offsets... in the Macro menu. Thethree ellipses (...) after the
menu choice indicate that another menu will open after you select this choice. Pick
the type of variable you want and click the left mouse button. A dialog box will
open with all the variables to that group. The next figure shows the Macro menu.
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Program Y ariables *

Local Variables

Common anables 4
Lathe Diameter Offzets [x]... *
Lathe Taoaol Length Offzetz [£]... 2
Lathe Tool Fadius Offzets [R]... k

Offzet Wectar W ariables
Y Bz Geometry Offzet

bill Tool Length Oftzetz H]... r
Mill Tool B adive Offtzets (D). L
Work Coordinate Y ariables r
Abzolute Pozition Y ariables Clrl+F3

M achine Coordinates Clrl+F11
YWhork Coordinate Yanables Chil+F5

Skip Signal Chl+F7
Commands [WHILE-DO, Etz]  Chrl+F3

b ath Operatorz Chrl+F3
System Y ariables Shift+F11

The Macro menu

The dialog box that opensis common to al the variables. The value of the variables

change depending on the menu selected. When you see the variable you want to
insert into the program, click on it. The variable will be highlighted. See the next

figure for details.

acro Pro Editor Reference Data

G54-G59 Work Offsets

#5222 Y Axis Fixture Offzet G54 |
#5223 £ Axiz Fixture OFffset GH4
#5224 A Axis Fixture DOffset G54
#5225 B Axiz Fixture Offset GH4
#5241 X Axiz Fixture Dffset G55
#5242 ¥ Axis Future Offset G55
#5243 £ Axiz Fixture Dffset G55
#5244 A Axis Fiture Offset GBS
15245 B Axiz Fixture Dffset G55
#5261 X Axiz Fixture Offset GB6
#5262 Y Axiz Fixture Offset GH6
#5262 £ Axiz Fixture DOffset GB6
#5264 A Axis Future Offset GH6
15265 B Axiz Fixture Dffset GB6
#5281 X Axis Future Offset G57
jij_?jﬂ? Y Awiz Fixtura MNffzeat Eﬁ?"!:l
1 »

Inzert | Exit Help

A Variables dialog

Y ou will notice a short description to the right of the variable. The description is

used to help you identify the variable before selecting it.  Click Insert to Insert the
variable into your program. Y ou can also click on Help to open the file.
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Customizing Macro Pro's Data

Each menu loads a file from the Macro Pro Editor\data folder. It’sfairly obvious
what menu item each file belongsto. For example, \data\G54CoorVar is the file that
is loaded with the Work Coordinates G54-G59 menu.

If you would like to edit one of the filesit’s very easy. Click on File, Open, then
click on Files of type and select All Files. Now double click on the Data folder. You
will see all of thefiles. Click on the one you want to open. In the next figure the
Fanuc 10M is selected:

Open
Lookin: |3 data =l x| [z
#] drilchrt ] 200005 ] haasl
Fimbg M5 haASMILL
f0Tos Frmg Z| Lo2Om.txt
1045 5T machine
[#] 1075 ] f6MmE ] Mazaki 32
fleMG f6To MhyDacs
1| | i

File name: If'l kG Dpen I
Filez of type: I.-'l'«ll Filez [*.%] j Cancel |

[ Open as iead-only

Open a Menu file for editing

Click Open to open thefile in Macro Pro. When the file opens you will recognize
the entries. Scroll to where you want to add or edit an entry. To add an entry, press
Enter to add anew line and then type the new data. Do not use acommain the line.
If you do the commawill be interpreted as a separator and the line will be broken.
Press the space bar and then the TAB key to separate a variable from its description.
If you make a mistake you can use the standard editing keysto fix it. If you get
completely mixed up simply close the file without saving it.

The Tool Bars

The Standard Tool Bar

The next figure shows the standard tool bar icons. If you have used Microsoft Office
97 you will recognize most of the buttons. To use a function on the toolbar, simply
click theicon. If you forget what a button does, hold the mouse over the button. A
description of the function will be displayed as atool tip.

Programmer's Guide
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hzdEd&E

The Sandard Tool Bar

The Edit Tool Bar

The Edit Tool Bar contains all of the menu items from the Edit Menu. The four
Buttons at the top of the figure are the standard Cut, Copy, Paste and Clear All. Row
two contains Undo, Redo and Select All. The third row is Insert Time/Date, Find,
Find Next and Replace. Finally, the last row contains Syntax Check, Add Comments
and Remove Comments.

Edit E

The Edit Tool Bar

The Reference Tool Bar

The reference tool bar opens the optional tools from CNC Helper. If you purchase
CNC Helper the Tools menu and the Reference menu are enabled in Macro Pro.
Thistool bar contains buttons for the Drill Chart page, the Thread Data database and
the Screw Dimension database.

Ref x|

1§ rem ror oz B

The Reference Tool Bar

Customizing the Tool Bars

Y ou can customize the existing tool bars or create your own. To get started Right
Click on the tool bar and select customize. See the next figure:

|7 Standard
v Edt

Customize Tool Bars

To create anew tool bar click New and enter aname for the tool bar. Click OK and
then click on the Commands tab. Click on File, Edit or Ref to bring up the
commands available on that tool bar. Now select atool from the Commands listbox
and drag it onto the new tool bar. It's that ssimple!
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Mew Toolbar i

Toalbar Mame:

iM_l,lBarI

(] i Cancel

Create a new tool bar

Using the Probe Cycles Menu

Macro Pro has a menu that helps you write probe cycles. When you select acycle, a
new dialog box opensthat is specific to the cycle. See the next figure.

Enter Cycle Parameters for £ Axiz Measure i

— Pozitioning Inputs ——————— — Ophonal Inputs

1. ¥ Start Point: ; [E] Experience ¥ alue: ;

0.0

2_ ¥ Start Point: 0 [F]1 Feed Back 0-1: ;
1
-.25

3. Pozition Feedrate: ; 00.0 [H] Tolerance ¥alue: ;
4_ 7 Depth To Probe: ; [M] True Position: ;

[S] Work Offset Number: |
[T] Tool Offset to Update: [
[U] Upper Tolerance: ;.................,
[¥] Null Band: [

[@] Overtravel Amount: ;Zﬁl

Print Options

{3 Ho Printed Dutput
) Print W/0 Header

) Print W¢ Header

The Z Axis Measure dialog

Y ou enter values for each choice and then click OK. Macro Pro enters the code for
the protected positioning moves and appropriate probe cycle. If you decide not to
continue, click Close to exit without entering the code into your program.

The Sample Code shown in the lower right corner of the screen shows you the type
of cyclethat will be produced.
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The Custom Entries menu

The Custom Entries menu allows you to add up to 25 of your own reference tables to
Macro Pro. To add your own entry simply create a standard text file (ASCII File)
using Macro Pro or any word processor that can save afile asan ASCII file.

The same dialog that is used with the other reference data is used with the custom
entries. Each linein thefile will be displayed on a separate linein the list box. Do
not use acommain the line. If you do the commawill be interpreted as a separator
and the line will be broken. If you want to be ableto click Insert and have the first
word on the line inserted into your program you must have a space between the first
word and the second. You can use a TAB after the space.

When you are finished adding data to the file save it the \data folder. The file name
will become the title for the menu so choose the filename carefully. You must use a
TXT file extension when you save the file.

For example a good file name for the M codes for an Okuma L C20 might be Lc20m.
Here is what the menu would look like if you saved Lc20m.txt to the \data folder:

Le20m I

Custom Menu

The Window Menu

Macro Pro is now an MDI editor. This means you can open more than onefileat a
time. The Window menu allows you to switch between files and control the way the
files are displayed on the screen.

LCazcade
Tile

Arange lcons

1 D:APROGRAM FILESSPROGRAMMIMG UMLIMITEDSMACRDO PRO EDITORNSPELL.PRO
v 2 D:AFROGRAM FILESYPROGRAMMING UMLIMITED MACRO PRO EDITORMSAMPLET.PRO

The Window menu

Cascade

This menu item arranges the files so that the titles of each file are visible. Thisis
similar to file cards in an index, you can see each file and immediately click on it to
bring it to the front. See the following figure for alook at cascaded files.
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__'.'.' Macro Pro Editor

Fil=  Edit Search Macro Probe Cycles Custorn Options  Window  Help
DEaHS| |t nBe o-c-mEms, Y =2

B D:APROGRAM FILESAPROGRAMMING UNLIMITEDAMACRO PRO E.. M=l E3
B3 D:A\PROGRAM FILESA\PROGRAMMING UNLIMITEDAMACRO PRO E... [H[=] E3

00620 |
[PFROBE FIXTURE CENTER])

G91G3020

GI1G30Y0

GIOT24TOME

[PRESET G54 X0 Y0 Z0 A0 BD)
#5221=-12.9880
#5222=-8.0703
#5223=-18.9990

<]

[if¢]

| Inzert |Line=1 of 71 Column=1

Macro Pro Cascaded

Tile

This menu item arranges the files horizontally so that you can work on each file.
Thisis very convenient when you want to copy code from one program to another.
The following figure shows the same files tiled.

__'.'.' Macro Pro Editor

Fil=  Edit Search Macro Probe Cycles Custorn Options  Window  Help
DEaHS [t mBe - -mEMs, Y =2
g D:A\PROGRAM FILESY\PROGRAMMING UNLIMITEDAMACRO PRO EDITORASAM. .. [H] E3

F4
00620
[PROBE FIXTURE CENTER]

(1411499 10:06:11 PM])
[ TOOL BREAKAGE DETECT ]
[ MACRO FOR ElA ]
[SET J57=8135 FOR PROG. NO ]
SFT .I58=135 FNNIR M135 CAlL 1 x

| Inzert |Line=1 of 71 Column=1

Macro Pro Tiled
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Arrange Icons

Open filesin Macro Pro can be minimized to icons at the bottom of the screen. The
Arrange Icons item putsthese iconsin neat rows. Thisonly worksif al filesare
minimized.

Open files menu

Thefiles listed below the Arrange Icons item are the currently open files. You can
click on and file to make it the active file. Thisisvery useful when you are editing
severa files and want the active one to be maximized. Simply click Window and
select the file you want to activate.

Using the On-Line Help

Macro Pro contains has extensive On-Line help for the Custom Macro language in
addition to Macro Pro. Asyou work on a macro program, use the On-Line help to
look up variable definitions and see examples of how to apply the macro language.

The help file is a complete Windows Hypertext program which means you can
search for keywords or topics. If you are not familiar with using Help, see you
Windows manual or experiment on your own.

To access the On-Line help, click the Help menu. Y ou can select either Help on
Macro Pro or on the Custom macro language. See the next figure.

LContents
Search

Custom Macra Contents
Custorm Macro Search

Yw'eb Support 3

On-Line Ordering
Suggestions

About...

The options, Contents and Search apply to the Macro Pro editor and the two choices
for Custom Macro open the language Help file. Please take time to go through the
Custom Macro helpfile at |east once.

The Macro Pro Editor Help menu can also take you to the Programming Unlimited
web site if you have an Internet connection. The Web Support menu has the
following sub menu:

Home Page
Tipz and Tricks
FaQ

Support Menu

These choices will take you to the Home page where you can look for
announcements, the Tip and Tricks page where you can see more macro examples
and to the FAQ (Frequently Asked Questions) page.
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Suggestions

If you have an Internet connection and would like to give us direct feedback about
the Macro Pro Editor simply click Help, Suggestions. Y ou will be taken to a
suggestions form on the Programming Unlimited web site.

Context Sensitive Help

Macro Pro aso has Context Sensitive Help. This means you can press the F1 key
under most circumstances and receive help about the selected button or control.

Context Sensitive help is even available when you have a menu item highlighted. To
use the context sensitive help with a menu, simply highlight the menu choice and
press F1 while still holding the mouse button down.

Take advantage of the context sensitive help to make learning Macro Pro easy.
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Chapter 3 - Communications

Sending your Macro to the Control

What you will need

Macro Pro allows you to quickly and easily create macro programs for your control.
Y ou will then need to use a communications package to send the program to your
control.

If you are using a CAM system, use the communication mode of the CAM package
to send thefile. If you don't have a CAM system you can use the HyperTerminal
program that came with Windows 9x and NT.

The HyperTerminal program should be set up to send and receive ASCII characters

using 7 bits, even parity and 2 stop bit. A baud rate of 4800 works very well for
most shop environments.

Mew Connection Properties !

Phorne Mumber | Settings |

= Mew Connection Change [con... !

Country code: ILInite:j States of America [1] j

Enter the area code without the lona-distance orefis.

Area code: ]

Phone number: i

Conrect using: I Direct to Com 1 __ﬂ

¥ Wze courtnycode andlares code

0k Cancel
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Configure Hyperterminal to use a com port

To configure HyperTerminal, select File, Properties, Settings. Select Direct to Com
1 under Connect Using. Click Configure to set the com parameters. Finally select
Settings, ASCII Setup. Under ASCII Receiving put a check in Append Line Feedsto
Incoming Line Ends.

COM1 Properties i

Part Settings ]
Bits per second: ;48["] __"_i
Data bits: ;? :j
Parity: ;Even ;j
Stop bits: ;2 :j
Flow contral: [y
Advanced... i Bestore Detaults i
1]4 i Cancel i Sy i

Configure Com Parameters dialog

Setting the Control Param eters

The control must be set for ISO communication using the same data communication
specifications. The following tables list parameters for several controls:

To set parameters on the System 6 control, you must switch the Memory Enable
switch inside the control cabinet to Enabled. Y ou will then see the alarm P/S 100 on
the CRT. Thisisto notify you that you are in parameter enabled mode. Y ou must
be in MDI mode to set parameters.

Fanuc 6M/T Control

Parameter Value Setting
311 1200 BAUD 10110111
312 1200 BAUD 10110111
340 Input Device 2
341 Output Device 2

SETTING Page Even Parity & ISO Code Format
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The System 10 through System 15 use the same parameters. To set these
parameters, use the setting page and search for parameter 5110. If you use the
Setting page, you will have to set parameter 8000 (Parameter Write Enable) to 1.
Y ou will then see alarm P/S 100 on the CRT. Y ou must be in MDI mode to set

parameters.
Fanuc 10-15M/T
Parameter Value Setting

0000 00001010

5110 Device Type 5

5111 Stop Bits 1

5112 Baud Rate 6 = 300 Baud
8 = 1200 Baud
9 = 2400 Baud

10 = 4800 Baud

11 = 9600 Baud

See your Fanuc Operators manual for additional settings to use with your control.

Making the Cable

The cable to connect the computer to the machine tool is easily made. Y ou will need
one male and one female 25 pin "D" connector. These are available at most
electronics supply houses or Radio Shack. Y ou will also need 3 conductor shielded
cable. The pin outs for each end are as follows:

Computer Connector

Control Connector

9 Pin 25 Pin 25 Pin
Pin 3 Pin 2 Pin 3
Pin 2 Pin 3 Pin 2
Pin 5 Pin 7 Pin 7
Pin 4-Pin 5 Jumped
Together

Pin 6, Pin 8, Pin 20
Jumped Together

Never Use Pin 24 On Control Side (12v).

4800 BAUD UP TO 250 FT.
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Appendix A - The Macro Pro Files

What Does the Install Program Do?

The Macro Pro Directory

Theinstallation program creates a directory for the Macro Pro files. The default
directory name is Program Files\Programming Unlimited\Macro Pro Editor. You
have the option of changing the default but we recommend using the default. This
directory is created on the hard drive you chose during setup. The default driveis
the drive that Windowsisinstalled on. The installation requires less than 6 MB of
disk space.

The Macro Pro Editor directory structure looks like this:

Program Files\Programming Unlimited\Macro Pro Editor — Program Files
DATA Folder— Text Files containing macro variables and other data.
Sampl es Folder— Sample macro programs.

Help Folder — Macro Pro's Help files

In addition there will be a Programming Unlimited folder under the Common Files
Folder in the Program Files folder. Thisfolder contains macro32.mdb which isa
database shared between Macro Pro and CNC Helper.

The Macro Pro Files

Macro Pro usesit's own initidization file, Macro Pro Editor.INI whichisinstaled in
the Windows directory. The following additional files are copied to your
Windows\System directory (system32 under NT):

Filel=MSVBVM50.DLL
File2=STDOLE2.TLB
File3=EMEDIT32.0CX
FileA=OLEAUT32.DLL
File5=OLEPRO32.DLL
File6=COMCAT.DLL
File7=ASYCFILT.DLL
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FileB=COMDL G32.0CX
File9=INICON32.0CX (In the Program Folder)
Filel0=MFC40.DLL
Filel1=MSVCRT40.DLL
File1l2=MSMASK32.0CX
File13=C:\WINDOWS\Macro Pro Editor.INI
Filel4=DBGRID32.0CX
File15=DBLIST32.0CX
File16=SY SINFO.OCX
Filel7=MFC42.DLL
File18=MSVCIRT.DLL
File19=MSVCRT.DLL
File20=MSJET35.DLL
File21=MSJTER35.DLL
File22=VBAJET32.DLL
File23=VBAR332.DLL
File24=MSJINT35.DLL
File25=MSRD2X35.DLL
File26=M SREPL35.DL L
File27=VB5DB.DLL
File28=EMEDIT32.0CX
File29=ACTBAR.OCX

The Macro Pro Editor directory will contain the following files:
Sample Filesin the Samples Folder
Various Macro Programs stored in the Samples folder.

Executable Filesin the Macro Pro Editor Folder

MACRO.EXE The Macro Pro Executable File
MACRO32.MDB The Code Library Database
Help Filesin the Help Folder

ACHART.HLP ACHART Program Help File
BOOK.HLP Macro Language Help File
CNC Helper.hlp CNC Helper Help File

Macro Pro Editor.HLP ~ Macro Pro Help File

Text Files

ACHART.TXT Readme Filefor ACHART
README.TXT Macro Pro Readme File (May not exist)
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TipofDay. TXT The text file containing startup tips.

Removing Macro Pro
If you ever need to uninstall Macro Pro, use the following steps:
1. Open the Control Panel and select Add/Remove Programs.

2. Select "Macro Pro Editor" and click Add/Remove. If you also have
CNC Helper installed do not delete the shared files when prompted.

3. Delete the Macro Pro Editor Folder in the Program Files Folder.
Simply highlight the group and press Delete until all of the Icons are
deleted. Thisfolder may be deleted by the uninstall program.
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Glossary of Terms

dialog box

A form that opens allowing you to enter data the program needs to continue. For
example, when you save afile, adialog is used to enter the filename.

ASCII file

A file with no special formatting. The term is an abbreviation for American Standard
Code for Information Interchange. Thisis a standard method of encoding
alphanumeric charactersinto 7 or 8 binary bits.

file extension

The Disk Operating System (DOS) used by Windows allows a three character
combination after the period in afile name. For example, sample.pro. Y ou can use
three characters for the extension.
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